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PREFACE

Welcome to the "MacFinish VideoID" user manual.

May we recommend you to gently leaf through the entire manual first, just to have an initial idea of how the book is
structured. As we cannot possibly explain all details simultaneously, this might help you a bit in understanding and tracing
things back. Of course, the table of contents will also help you in doing so.

Please note that all pictures are examples, the delivered version can be different than shown in this manual please inform
yourself before purchase.

If you, after reading this document, have any further question regarding the operation or service of this or any other
TimeTronics equipment, please contact your local distributor or TimeTronics directly, by email: info@timetronics.be, or call
us at +32 (0) 14 23 19 11

Please also contact us if you have any remarks or advise regarding this user manual: info@timetronics.be.

Good luck with MacFinish VideoID and thank you for your confidence in the TimeTronics products and services.

The editors.

© Copyright 2016 TimeTronics. All rights reserved.
TimeTronics NV
Lammerdries 23b
B-2250 Olen
Belgium 
Tel.: +32 (0) 14 23 19 11

Disclaimer
Under no circumstances shall TimeTronics be liable for any loss, damage or expense suffered or incurred with respect to
any defective product. In no event shall TimeTronics be liable for any incidental or consequential damages that you may
suffer directly or indirectly from use of any product. Windows, Windows XP and Windows VISTA are registered trademarks
of Microsoft Corporation. 
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1. HARDWARE SETUP

1.1. Complete setup

In a complete setup, your system contains the following
parts:

· MacFinish Ethernet + PC (not included in VideoID
-configuration

· Samsung Q1 (or an other portable computer)

· MFVideo ID camera

· An Ethernet hub

Connect your MacFinish pc and camera to the Ethernet
hub.

 Place  the  Samsung  Q1  and  the  MFVideo  ID
camera  on  the  desired  place.  We  recommend
you place it some meters behind the finish line
on the inside of the track. 

 Connect the Samsung Q1 (or another portable
pc) to the Ethernet hub (using a long UTP CAT5
cable from the central hub to the inside of the
track);  be  sure  your  computer  network
(consisting  of  at  least  two  pc’s,  namely  the
MacFinish pc and the Samsung Q1) is managed
right.  If  you  don’t  need  to  be  connected  to
another network, we recommend you use static
IP addresses. 

 Connect the MFVideo ID camera to the Samsung
Q1 using the USB cable. 

Note:  For  more detailed information concerning the setup of  your computer network,  see  Appendix A:  Managing a
computer network.

1.2. Simplified setup

In a simplified setup, you don’t use the Samsung Q1 (or another portable pc) for the MFVideo ID software, but you use
the same computer for MacFinish as for MFVideo ID. This allows you to eliminate the need for a computer network, but
the distance between the MacFinish pc and the identification camera is limited.

Note: With use of the standard USB cable, the distance between MacFinish pc and identification camera is limited to 5m.
But you can extend this to 15m using our USB extension cables (for more information: contact us at info@timetronics.be).
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2. SOFTWARE INSTALLATION 

Note: For the installation of the MacFinish software, consult the MacFinish manual.

Note: On the minipc (if delivered with the system), the software and camera drivers are already installed at TimeTronics. 
You can directly start using the system.

Follow the next steps to correctly install the MFVideo ID software.

• Do not plug-in the MFVideo ID camera before the software is installed.

• Put the MFVideo ID cd in your cd player or download and unzip the latest software form our website to your local 
hard drive.

• If the cd does not start automatically, or if you have downloaded the
software, start the installation by double-clicking TT_INSTALLER.exe.

• After the Welcome screen, you will see a list of prerequisites. A prerequisite is a small software package that has
to be installed before MFVideo ID can work.

• For MFVideo ID, there is only one prerequisite, namely “Microsoft
Visual C++ 2005 Redistributable”.  If  the prerequisite  is  greyed
out, it is already installed.

• In the next screen you get the overview of the products that will
be installed, here it is only MFVideo ID.

• Now you are ready to install everything. If you click “Install” on the next screen, first the installation of the
prerequisite is launched (if it was not already installed on your system), afterwards the installation of MFVideo ID
is launched.

• After  the  Welcome  screen  and  the  licence  for  the  MFVideo  ID
installation,  you  can  choose  the  type  of  installation  (Typical,
Custom or Complete). We recommend you choose for a complete
installation.
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• After clicking “Install” the installation will begin. Wait for the installer to do it’s job and finally click on “Finish”.
The installation is successfully completed.

• Now you can plug-in the camera and let Windows look for the driver on your hard drive, not through Windows
Update.

For Windows XP, follow the next screenshots.
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2.1. Installing Unsigned Drivers in Windows 8 or Windows 10

2.1.1. Installing Unsigned Drivers in Windows 8

Check if the USB driver for the MacFinish2D is installed

Move your mouse pointer to one of the extreme right corners, slide along the right edge and 
click on “Settings”.

Type in “device manager” and start the “device manager”

When it is installed properly you will not see any warning and you will be able to use the 
MacFinish without problems. But if you see an error message at the MacFinish2D then please 
continue this guideline.
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2.1.1. Installing Unsigned Drivers in Windows 8 or above

Again, do this only if you’re sure about it. Follow the steps precisely:

1. Open control panel:
Move your mouse pointer to one of the extreme right corners, slide along the right edge and 
click on “Settings”.

At the bottom of the charm, click on “Change PC settings”.

This should open up the special Control Panel for Windows 8.

2. Restart in advanced startup mode:

Click on Update and recovery

8
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Click on Recovery and then on Advanced startup – Restart Now 

The system will restart and provide you a menu, prompting you with choices on how to 
proceed. Click on “Troubleshoot”

Click on “Advanced options”

Click on “Startup Settings”

Click on “Restart”. The computer restarts again, this time presenting you a list of options using 
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which you can change the parameters of your current system startup.

In the list, there is an option, “Disable driver signature enforcement”. Here the relevant 
function key (F7) has to be tapped.

Restarting will enable driver signing enforcement and continue to protect the system from 
unverified drivers. However, drivers installed continue to remain as they are and are usable on 
your Windows 8 system then on.

3. Install your driver:

32 bit system: C:\Program Files\TimeTronics\MacFinish 2D\drivers
64 bit system: C:\Program Files (x86)\TimeTronics\MacFinish 2D\drivers

Copy the “MacFinish 2D USB.inf” on your desktop
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Move your mouse pointer to one of the extreme right corners, slide along the right edge and 
click on “Settings”.

Type in “device manager” and start the “device manager”

Right mouse click on the MacFinish2D and click on “Update Driver Software”

Click on “Brows my computer for driver software”
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Brows on your desktop (in this case Kim is the user of the mentioned desktop) and press next.

Windows Security message will pop up. Click on “Install this driver software anyway”

Once the installation the following window should pop up
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The result should be that the MacFinish 2D does not have an error message.

That’s it!!! 

----------------------------------------
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2.1.1. Installing Unsigned Drivers in Windows 10

Press on the search button (magnifier glass) and type “Device Manager” and press enter or 
click on “Device Manager” in the search results.

If you see an error message at the MacFinish2D then please continue this guideline. Otherwise 
contact us at TimeTronics.

Installing Unsigned Drivers in Windows 10

Again, do this only if you’re sure about it. Follow the steps precisely:

1. Open Settings:

At the bottom left press on the windows button and click on “Settings”.
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2. Restart in advanced startup mode:

Click on Update & Security

Click on Recovery 

Click under Advanced startup on “Restart now” 
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The system will restart and provide you a menu, prompting you with choices on how to 
proceed. Click on “Troubleshoot”

Click on “Advanced options”

Click on “Startup Settings”

Click on “Restart”. The computer restarts again, this time presenting you a list of options using 
which you can change the parameters of your current system startup.
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In the list, there is an option, “Disable driver signature enforcement”. Here the relevant 
function key (F7) has to be tapped.

Restarting will enable driver signing enforcement and continue to protect the system from 
unverified drivers. However, drivers installed continue to remain as they are and are usable on 
your Windows 8 system then on.

3. Install your driver:

32 bit system: C:\Program Files\TimeTronics\MacFinish 2D\drivers
64 bit system: C:\Program Files (x86)\TimeTronics\MacFinish 2D\drivers

Copy the “MacFinish 2D USB.inf” on your desktop

Press on the search button (magnifier glass) and type “Device Manager” and press enter or 
click on “Device Manager” in the search results.
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Right mouse click on the MacFinish2D and click on “Update Driver Software”

Click on “Brows my computer for driver software”

Brows on your desktop (in this case Kim is the user of the mentioned desktop) and press next.
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Windows Security message will pop up. Click on “Install this driver software anyway”

Once the installation the following window should pop up

The result should be that the MacFinish 2D does not have an error message.
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2.1. Installed VideoID properly installed but can’t see VideoID 

If you have installed the latest VideoID software properly it can occur that in a very few 
occasions you do not see your VideoID in the startup screen of the VideoID software. In this case
please run following software. 

http://www.timetronics.be/Software/LuCamSoftware-v6.5.0.zip

In case you would face further problems please contact TimeTronics.

----------------------------------------
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3.   Sharing MacFinish VideoID folders on a computer

More about fixed IP setting and folder sharing for Window XP you can find in Appendix A, B and C. 

Following  actions  are  needed to  make  sure  that  the  "MFVideoFiles"  folder  is  shared  on  the  VideoID  computer  for
MacFinish access.

Please also note that local virus scanners and/or firewall has to be switched off if not configured properly.
More information you will have to search in the manual of the your local installed virus scanner and/or
firewall

3.1. Make sure that the “Sharing” settings are correct:

See below, look at the "Sharing" TAB of the properties of the "MFVideoFiles" folder on your VideoID computer. 
"Everyone" should have "Full" access (= read and write) to this folder.

3.2. Make sure that the “Security” settings are correct:

See below, look at the "Security" TAB of the properties of the "MFVideoFiles" folder.
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33. Make sure that the “Sharing” is “on” for public folders, but “password protected 
sharing” is “off” in “general” WINDOWS setting (Control panel):

Especially for mixed versions of Windows, for example if VideoID is used on a pc with Windows 10 and MacFinish is 
used on pc with Windows 7.3)

3.4.     Advise for   testing  , after you believe you have completely and correctly made these 
settings;

a) Use  your MacFinish computer to log in to the VideoID computer. If you do not know how; please follow this 
procedure;

* Find out the "IP-address" of your VideoID computer
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* Open a browser window on your MacFinish pc, and type like "\\172.17.100.17" but replace the "172.17.100.17" 
with YOUR Ipv4 address of the VideoID pc.

b) You should now see which folder(s) are shared on the VideoID computer, and be able to open the folder 
"MFVideoFiles" WITHOUT PASSWORD, otherwise your step (3.3) was not successful, and should be checked again !!

c) You should now be able to create file(s) on that folder "MFVideoFiles" by dragging files from your MacFinish pc 
desktop to the folder "MFVideoFiles" on your VideoID pc. If this is not possible, the MacFinish software will have 
same problems to read and write in this folder, and not be able to show the Video pictures, and perhaps will crash 
during MacFinish operation !

d) You should also be able to copy, and delete file(s) from that folder "MFVideoFiles".
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4. MF VIDEO ID SOFTWARE
You can start the software by double-clicking on the shortcut on the desktop, or in the startmenu folder, or else you can
find the program at C:\Program Files\TimeTronics\MFVideo ID\MFVideo ID 1.1.0.0.exe. 

  

4.1. Overview of the screen

After starting the software, you will see the following screen.

 

The fields you should notice are:

1. The TCP/IP port the software is listening to (default 2000 but will increase to 2001, … if the port is not available).
This is an important setting in the MacFinish software later.

2. Here you can see the IP address of the MacFinish that is connected.

3. These pictures indicate the state the MacFinish is in. The pictures are not clickable; they are controlled through 
the connection with the MacFinish software. Remember that the MFVideo ID software does not need an operator; 
it is fully controlled by the MacFinish software.

4.2. Overview of the menu's

There are three menus in the MFVideo ID software: File->Preferences…, File->Camera Properties… and Help->About 
MFVideoID…

4.2.1. File  Preferences...→

These are some general preferences of the software, an overview:

1. The number of frames to record before and after an arrival.

2. Where to store the video files while recording (we recommend
you choose Local). If you choose local, the files are stored on the
computer where the MFVideo ID software is running, otherwise
they are stored on the MacFinish pc. If you choose local, your
video files will be more fluent, because the saving of the recorded
image is not influenced by network traffic.

3. The file format in which the video files are stored. You can choose between MFV (MacFinish Video) or AVI. We
strongly recommend to use MFV, because the file size will be approximately 4 times smaller than AVI files and
conversion to a standard format can always be done afterwards.
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4.2.2. File  Camera Properties...→

In this window, you can see the settings for the camera.

1. The exposure time in tenths of milliseconds (10 means 1 millisecond).

2. Colour calibration: you can influence the general gain and the gain for every colour apart (red, two times green 
and blue).

3. By clicking on the button “Auto White Balance” the camera will take one shot and calculate the different values 
for the gains for you. If you are not satisfied with the result, click again.

4. The width and the height of the window can be set in software; the maximum values are 1280x1024. These 
values have to be multiples of eight.

5. You can select the framerate of the video you take. We recommend values between 15 and 30 frames per 
second. Less: than you might miss some fast athletes; more: the file size will be too large, which leads to delays.

6. The position of the subwindow can be controlled. If you don ‘t take the full 1280x1024 pixels (we recommend 
something between 504x320 and 800x600), you can move the window of vision of your camera. The button in 
the middle is to center the subwindow, which gives the best results.

Note: 

• All these settings take immediate effect; you can see the changes in the preview screen.

• Because this software is often used on tablet pc’s, the user interface is what it is. It can take some time to get used 
to, but afterwards you will agree that it is very user-friendly.

• In most input fields, you can see three different
parts:

1. It is possible to type a number here.

2. By clicking the arrow up or down, the value increases or decreases.

3. If you click and hold the mouse (or pointer) down, a slidebar will appear. If you hold the mouse (or 
pointer) and move over the slidebar, the value will increase or decrease and the slidebar will be filled or 
emptied.

4.2.3. Help  About MF Video ID→

You will see the next window:

 

There are two important items in this screen:

1. The software version you are using.

2. The serial number of your camera.

25



2016v2 Manual MacFinish VideoID

5. THE MACFINISH SOFTWARE
The MacFinish has to link to the MFVideo ID software, so we have to do some settings here as well.

5.1 Connection to MF Video ID

• To connect from MacFinish to MFVideo ID, you have to fill in the IP address
of the computer where MFVideo ID is running (e.g. Samsung Q1) and the
port number on which the MFVideo ID software is  listening. You can do
these setting in MacFinish via menu File->Preferences…

Note: 

• Read Appendix A.2 to learn how you can get your IP address.

• If you use MacFinish and MFVideoID on the same computer, you
can use the localhost IP address 127.0.0.1, port 2000.

• After clicking “OK”, the connection is made. You can follow the status of the
connection in the statusbar.

• By double-clicking on “Error on an ethernet connection”, a window
appears where you can see if it is the video connection that causes
an error.  If  you  click  on the  symbol  to  the right  of  the video  IP
address, MacFinish will try to renew the connection. If the connection
can not be made, the symbol stays as it is, otherwise it will turn into
a green check symbol.

5.2 Reading out the image

After the connection is made, you can work as you are used to. MFVideo ID does not need any operations; it is controlled 
by the MacFinish software.

After saving the image, MacFinish will ask you whether you want to copy the video file together with the MacFinish file, or 
you just want to use it once. If you choose to copy it, this takes some seconds. If you choose not to copy it, than you can 
only use the video file once. Afterwards it is not linked anymore to your MacFinish file.

If you get one of the following messages, your shared folder is not accessible or does not exist. Read Appendix B: Shared
folders.

Note: the video file is a separate file with the same name as the MacFinish file, but with different extension. Those two
files have to stay together. If the video file is not in the same folder as the MacFinish file (due to manually copy the
MacFinish file, but forgetting the video file), it will not be visible.
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5.3 Using the video file

5.3.1. How to identify athletes

If you move with the mouse over the photofinish image, you will notice that the video image moves to. The times in both 
files or linked.

So if you click to add the time to the result table, the shot you see in the video screen will be the one of the athlete you 
point to. It is easy to read his number and choose that number from the list.

• If the number is not readable, there are several options you could do.
• If the number is too small, just click on the video screen and it will zoom in.
• If the number is better readable in a previous or a next shot, you can move in the video file by (look at the numbers 

in the screenshot below):

Possible actions:
1. Moving the slider

2. Use the buttons to go one shot further or one shot back

3. Play the whole video file

5.3.2. How to adjust some properties of the video image 

You can adjust three properties of the video file, offset, brightness and contrast.

Offset means a number of milliseconds time difference between the place in the photofinish image you point to and the 
shot you will see in the video file. This can be both positive (video is later than photofinish) as negative.
This offset is useful when you notice the numbers of the athletes are more visible some distance before or after the finish 
line.

Brightness and contrast are well known properties of images. The default brightness is 0, the default contrast is 100.

To adjust these values, change the number in one of the three boxes above the video file (from left to right offset – 
brightness - contrast). You can change these values by typing in another number, or by clicking the “v” after the numbers,
holding down the mouse and move over the slider that appears.
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APPENDIX A: MANAGING A COMPUTER NETWORK
We don’t claim this is a guide in how to manage a computer network. It is only a guide for those who just start using a
small network for use MacFinish together with of MFVideo ID.

The screenshots you see are taken on a computer running Windows XP SP2. For Windows VISTA it is similar, but take not
off APPENDIX C.

A.1 Assigning an IP Address

Open the properties of your Local Area Connection (Control Panel -> Network and Internet Connections -> Network
Connections -> right click on Local Area Connection and choose Properties).

Open the TCP/IP properties by selecting “Internet Protocol (TCP/IP)” and clicking the Properties button.

 

If your computer is not connected to a bigger network, you can not select “Obtain an IP address automatically”. You have 
to fill in an IP address you chose yourself.

Fill in a unique IP address for every computer (MacFinish and MFVideo ID). 

Note: the IP addresses you use should come from one of these ranges (don‘t mix ranges). 

X is a number from 1 to 255.
10.X.X.X (Subnet mask 255.0.0.0)
192.168.X. X (Subnet mask 255.255.0.0)
172.16.100. X (Subnet mask 255.255.255.0)

A.2 What is my IP Address

The easiest way to get your IP address is to open a Command Prompt window and type in the command “ipconfig” 
followed by <enter>.

Note: when you want to use MacFinish and MFVideoID on the same computer, you can use the localhost IP address 
127.0.0.1.
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A.3 Can I connect to the other computers

To see if you can connect to the other computers, you can “ping” to them.

Type in the Command Prompt window the command “ping + IP address of remote computer”.

In the picture below I tested if my computer was connected to the computers with IP addresses 172.16.100.19 and 
172.16.100.200. The first connection was OK, the seconds one failed.
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APPENDIX B: SHARED FOLDERS
As you have read before, MacFinish and MFVideo ID use a shared folder to exchange the video file. The name of the
shared folder is MFVideoFiles. Depending of your settings (see 4.2.1 - 2) this folder has to be on the MFVideo ID computer
(local) or on the MacFinish computer (remote).

We recommend that you check the shared folder
before  you  start  recording  MacFinish  images.
If the setting 4.2.1 – 2 is local, open a Windows
Explorer window on the MacFinish computer and
open  the  folder  “IP  address  of  MFVideo
ID\MFVideoFiles”. Try to create a new document
here. In the example below the IP address of
the MFVideo ID computer was 172.16.100.18. If
you don’t  succeed in  creating a  new file,  you
have to change permissions (on the MFVideo ID
computer) [or read the note below].

By installing  MFVideo  ID,  the  shared  folder  is
automatically  made  for  you  in  C:\Program
Files\TimeTronics\MFVideoFiles.

If you want to store the temporary video files on
the MacFinish computer, you have to make the
shared folder there yourself (setting 4.2.1 – 2 is remote).

Note: when you experience difficulties to access the folder from one computer to the other, it might be useful to use
Windows standard shared folder. Just copy the MFVideoFiles folder in “My Shared Documents” and be sure it is still know
as \\ip-adres\MFVideoFiles (enable sharing on the MFVideoFiles folder). The folder will now automatically get the security-
and user-settings of the standard shared documents folder.

B.1 What about Permissions

If you get the error described in 5.2, the MacFinish computer had not the rights to copy files in the shared folder. To
change  these  rights,  right-click  on  the  MFVideoFiles  folder  (on  the  MFVideo  ID  computer)  and  select  Properties.
Choose the “Sharing” tab and be sure “Share this folder” is enabled. Click on “Permissions” and add “Everyone” by clicking
“Add”, typing in “Everyone” and clicking “Check names”. Give everyone full control.

Note: If you keep on having problems in Windows VISTA with permissions, try to copy the MFVideoFiles folder to the 
folder “Public” (standard shared folder). The folder MFVideoFiles will inherit all default sharing and security properties of 
the “Public” folder. But make sure that the folder is shared itself too, so it is known as \\IP-address\MFVideoFiles and not 
as \  \IP-address\Public\MFVideoFiles.
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APPENDIX C: VISTA USERS
On Windows Vista, make sure the settings of the Network and Sharing Center (via Start -> Control Panel -> Network and 
Sharing Center) are as shown in the screenshot below. 

 

APPENDIX D: KNOWN ISSUES
When adjusting the width and height of the camera, the camera is sometimes not fast enough which leads to a crash or
no images from the camera. Restart the software and try again.
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APPENDIX E: HOW TO USE THE MF VIDEO IDENTIFICATION 
CAMERA WITHOUT MACFINISH

You can use our MFVideo ID camera as a camera to capture video, without getting the signals (ready, start, arrival) from a
MacFinish. Follow the next steps:

1. Be sure the camera is connected
and  the  driver  is  installed  (to
check, look if the orange LED on
the bottom of the camera is on). 

2. Open  MFVideo  (our  MacFinish
Video ID program), you can find
it on the desktop of the mini-PC
(MFVideo 1.0.0.5.exe). 

3. Do the settings you want, click on
Properties  and  you  will  get  all
possibilities.
Notice that the width and height
of the window can only be used
with MacFinish, in other words if
you capture video with an other
program you will always use the
full resolution (1280x1024 px). 

4. Open Windows Movie Maker (this
is  a  standard  Windows  program
on XP and Vista). You can find it
in  the  Programs  Menu  ->
Accessories  ->  Windows  Movie
Maker. 
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5. Select your camera as Video Capture Device

6. Chose where to put your recorded videos and with what compression (we recommend “Best quality for playback 
on my computer”). 

7. Click “Start Capture” and “Stop Capture” to start and stop recording video. 

8. Click “Finish” when you are done recording the video, your video will appear in the collection and is also stored on
disk in the folder you selected. 
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